Palette: The specific 256 colors a segment uses out of all the millions of available RGB colors Only a
concern on 256 color systems since true color and high color systems always have all the colors and 16
color systems all use the same 16 color palette.



ANM: An animation file created with Animcomp. These files play a sequence of images in order within a
single segment. ANM files created with other programs will not work in Screen Saver Studio Deluxe!



AVI: A common form of graphic movie. AVI's can only be played in Graphic Slot 1. The user of the screen
saver needs an AVI player on his system!



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Screen Saver
Studio Deluxe.



Adding Audio to a Segment

Sounds can make your screen saver come alive! If you have WAV or MIDI files, you can easily add them
to your screen saver. Click on the graphic below for specific help.
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Adding Graphics to a Segment

Graphics are the "actors" in your screen saver. There can be up to 10 different graphics per segment and
up to 50 copies of each graphic. Graphics can be static or they can be special "animations" that are
contained in a single file. They can be given different movement commands and can enter and exit the
screen with a variety of fade effects.

Click on the graphic below for more help.
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Adding Segments to a Screen Saver Document

Screen Saver Studio Deluxe can make screen savers with up to 1,000 different segments. Adding a
segment is a form of inserting a segment. To add a new segment to your screen saver, highlight an
existing segment by clicking on it. The segment you are adding will be inserted before the highlighted
segment. If you want to add a segment to the end of the screen saver, click on the End Of List segment.

&
To add the new segment, press <Insert> on your keyboard or click on the Insert New Segment Icon in the
Tool bar. When you insert a segment this way, it is automatically filled with the contents of the segment

before it.

If you want to insert a new segment that is a duplicate of some other segment in your document, simply
select that segment and copy it to the clipboard by pressing <Ctrl+C> or clicking the copy icon in the Tool
bar...

...then highlight a segment and click the Paste Insert Icon in the Tool bar or select Paste Insert from the
Edit Menu <Ctrl+A>. The copied segment will be pasted before the highlighted segment.

&

...or highlight a segment and click the Paste icon in the Tool bar or select Paste from the Edit Menu
<Ctrl+V>. The copied segment will replace the highlighted segment.

The following sequence should make this all clear...

The screen below shows a screen saver with one segment. The text tab is showing the contents of the
text field in all segments. As you can see, the text for segment 1 is a "1".
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Below, the End of List segment has been highlighted. The highlighted segment has its name in a blue
box.



E Uniited - Seraen Saver Shukn Dehecs

B Ed Wiem Jeoh b

i 1 e s W e B e L]

)

?'r:hl..%| :::t?)| Hr!l hmﬂl| Batid T
D =

Below you see the results of hitting <Insert> - the contents of Segment 1 are copied automatically into

segment 2. The new segment is also highlighted.
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Below shows the result after editing the text in segment 2 to "2". Then we copied this segment to the

clipboard by pressing <Ctrl+C>.
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Now segment 1 has been highlighted.
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If you then highlight segment 2 and use the Paste command, you will replace the contents of the

highlighted segment with what was on the clipboard.
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Adding Text to a Segment

Each segment can have one text message associated with it. Text always appears over all graphics - it is
the top-most layer. Just like a graphic, you can make the text move and control how it enters and exits the
screen

Click on the graphic below for more information.

Segment 1 |

Graphic  Text |Backgrnund| Audio I Timingl

— Define Text — Fading far Text
= Slowe Effect [50] Fast

4 [ [

Fade In I [nztantaneous j

-
4 F

Fade Out IInstantanenus j

Hation IStatinnar_l,l j Font... | [ Transparent Fade
o Speed [10] Fast — Test Starting Point
j J j Y IF'reset j I Dﬂ
- =
[ Keep Black Tranzparent [T Use Exact Faort f IF'reset J I =l
Clear | Usze Prior Segment Values |

View | oK I Cancel | Apply | Help |




Adding a Background Graphic or Color to a Segment

The background is the mat on which all other actions take place. It can be as simple as a solid color, or as
pretty as a full-screen scanned-in photo. Backgrounds always appear instantaneously at the beginning of
the segment and remain for the entire segment. All other graphics and text appear over the background -

it is the lowest layer.

Click on the graphic below for specific help.
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The Audio action list lets you pick how or when to play a sound:

Once- the sound is played once at the beginning of the segment. It may or may not be finished when the
segment ends, so it could continue into the next segment. See also Audio Check Boxes.

Continuously- the sound starts at the beginning of the segment and plays in a continual loop, so be sure
it sounds okay when repeated. If a sound is played in a later segment, it will stop the continuously looping
sound. To restart the loop, set it up again in another segment. In such a case, to make it seamlessly loop
from the end of the screen saver to the beginning, make sure to have a continuously playing sound in
Segment 1 - even if it's part of an Intro Clip - or else the sound will "jump".

Associate with Slot 1-10- plays the sound whenever any graphic in the chosen slot exits or bounces off
the edge of the screen. Multiple copies of graphics bouncing around can cause many sounds to be
generated. See also Audio Check Boxes.

Associate with Text- plays the sound when the text exits or bounces off the edge of the screen.




When the Allow Interruption within Segment box is checked, if a sound is playing when a new one is
supposed to begin, the current sound will be stopped and the new one played. Otherwise, the current one
continues until it is finished. This only affects sounds in a single segment! If a sound plays into another
segment, any new sound will always stop the current sound and begin the new one.

The Stop Sound at End of Segment check box, if checked, will make sure that any sound will be ended
when the current segment ends, even if the duration of the sound is longer than the segment.

These may be checked in any combination.



The Audio Clear button clears the audio selection to <none>. It leaves the check boxes and action
unchanged since these can affect sounds which began in a previous segment.



The Audio Select button calls up a standard file selection dialog that allows you to find WAV or MIDI files.
As much of the path as can be displayed will be over the select button after a selection is made.



The Audio Stop button stops any sound which was started by pressing the Test button.



The Audio Test button plays the sound or song you have chosen. You can go select another while the
current one is playing, or click OK to exit the dialog and stop the song.



The background preview window shows a sample of how the background will look. A tiled graphic will
show as much of the path name of the selected graphic as will fit and tile the graphic in the display
window, a solid color will show the selected color, and sticky will just be completely grey with no evidence
of a window outline.



The background Select button is dimmed out when sticky is selected, otherwise you must click here to
bring up the color selection dialog for a solid color background or a standard file selection dialog to select
a tiled graphic background. The selection dialog defaults to showing all supported graphic file formats.



A solid color background is just that - a solid color. It is the fastest way to draw the background. You will
need to click on the Select button to bring up the color palette. Click on the color you want for your
background, then click OK.



A sticky background retains everything that is drawn on it - it never erases. Objects that move across the
screen leave a trail as they go. This can be a very interesting effect. You need to have sticky selected in a
run of segments to retain the effect - as soon as a non-sticky (i.e. solid color or tiled graphic) background
segment is encountered, the screen will be cleared to whatever was selected in that segment.



A tiled graphic background will take the selected graphic and tile it - that is, repeatedly draw it over and
over again until the entire screen is covered.

It is important to remember when working with tiled graphics that you do not know what resolution the end
user of your screen saver will be running under. If you have a "full screen" 640x480 background graphic
and they are in 800x600 resolution, your background will be tiled - which may be undesirable. Similarly, if
you have an 800x600 graphic and the end user is in 640x480 resolution, they will only see the upper left
hand corner of the background.

The background is redrawn every update (see Update Rate) and it takes longer to draw many tiles than
fewer. Thus, a single pixel can be tiled to make a blue background, but this is much slower than tiling a
large blue graphic, which is slower than just using a blue Solid Color background.



Use the build browse button to select the icon for your screen saver screen. It calls up a standard file
selection box so you can find any ICO file on your hard drive. You can create your own icon using the Icon
Editor program (See more in the Icon Editor section)



In the build description box, enter any information you want to appear when the user selects the
Settings button for the screen saver. The text is automatically word-wrapped, so don't press <Enter>
unless you want to start a new line. Each line of the description text will be centered.

This text will be seen when a screen saver is installed, so you can use it as a read me. The description
text will not be seen if you build a presentation EXE.



The icon currently selected for the screen saver is shown in here. The icon appears as the icon for the
SCR file and in the settings dialog. You must have an icon - if you really don't want one, use the
CLEAR.ICO we've provided - it's completely transparent.



The 256 color use options give you control over the palette in your screen saver. The options are:

General Rainbow (Static) - this is exactly the palette you see while building and previewing your screen
saver in 256 color video mode. It makes a fairly good approximation for most graphics, but is bad for
photographs.

Global (Static) - this takes all the graphics from the entire screen saver and makes the single best
palette. The results are usually very good. There is never a palette flash between segments, but it can
take a while for the palette calculation during the build.

per Segment (Dynamic) - this takes all the graphics in each segment and determines the best single
palette. This is excellent for slide shows, but, if you don't fade each graphic to black before a new
segment, you will see a palette flash.

per Clip (Dynamic) - this takes all the graphics in each clip and determines the best single palette for
each one. This avoids palette flashing. between segments within clips, but not between the clips
themselves.

Palette selection only has meaning when you are in 256 color video mode when the screen saver kicks in.
For all other video setups, this setting is simply ignored.

See also Color Considerations



The reset button makes the icon the default icon - a monitor being saved by a life-saver. (Get it?)



Build SCR/EXE (File menu)

Use this command to create a screen saver file (and possibly a program to easily install it, too). For
more information, see Building New Screen Savers (.SCR files) or Programs (.EXE files).

Shortcuts
Tool bar: il

Command bar ﬂ

Keys: CTRL+B



Enter the build selection name which will be seen when you are selecting the Screen Saver from the
control panel. This name is limited to 20 characters -- it is not the file name.

Windows 95 Note! The screen saver control panel of Windows 95 will only show one screen saver with
identical selection names - the first one installed. If you build TEST.SCR with a selection name of TEST,
then make changes and build TEST2.SCR while keeping the selection name TEST, the control panel will
only show TEST, and it will point to TEST.SCR. So always change the selection name too, or you'l
wonder why your changes aren't showing up! (Windows 3.x will just show multiple copies of the word

TEST, so pick the right one!)



Choose what type of file to build by selecting the appropriate build type options from the drop-down lists.
You may create a screen saver (SCR file), or a presentation (EXE file). The presentation option creates a
program that runs only when you launch it and is exited only by a key press -- the mouse is ignored and
movement or clicks will not exit it like a normal screen saver.

You may create a file that will run on ANY Windows 3.1 or better system (including 95, 98 and NT) OR
one that will run ONLY on Windows 95, 98 and NT systems. The advantage of the second option is that it
is faster since it uses true 32 bit code, but of course, people with Windows 3.1 can't your file!

Making an installer is highly recommended since there will always be a .DAT file that you may forget to
give away with the regular file. If your build has AVls or MIDlIs in it, you will be forced to make an installer.
An installer is not the same as a presentation EXE! After this installer is run once, the SCR is installed on
the system and will function like any normal screen saver.

If you chose to make an installer, you will have the option of using compression. This can take a long time
on slower systems, but it should always be used for your final build since it can make the overall size
significantly smaller.



Building Your Screen Savers

After you have completed and saved your screen saver document to disk, you can build a Windows-ready
screen saver module (.SCR file) or a runnable program (.EXE file). Select Build SCR/EXE File in the File
Menu (Ctrl+B) and you will see the following dialog.

Click on the graphic below for more help.
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You must enter a selection name! After you've made the rest of your choices and click OK, you are
presented with a standard Save As... dialog to name the resulting SCR or EXE file - which must be a
standard 8 character filename IF you have chosen the any system option as in the graphic above. You
may use a long file name if you are building for newer systems. Choose the directory where you want to
save it (usually Windows for an SCR) then click OK.

A SCR or presentation EXE will always have at least two files. If you want to give your screen saver away
to friends, you should choose to make an installer so you'll never forget to give them one of the files. It will
not only make an installation file that installs the SCR file into the Windows directory, but it also makes it
the default screen saver!

If you have a MIDI or AVI file anywhere in your screen saver, you will be forced to create an installer!

If you make an installer you will be asked where and under what name to save it. In addition, you can
compress the installer - this takes a while, but can make it significantly smaller.

NOTE! It is important that you compile your screen savers on your hard drive and then transfer them to a
floppy disk. If your screen saver is larger than the amount of free space on your diskette, Screen Saver
Studio Deluxe may, in some cases, fail to notify you and continue to build your screen saver incorrectly.

Exit Screen Saver Studio Deluxe or press Alt+Tab to access your Windows desktop. You can then
activate your new screen saver by selecting it the same way you normally select a screen saver. (i.e.,
Windows 3.1 users should double-click the Control Panel then Desktop icons in the Main Program Group;
Windows 95 users should right-click on the desktop, select Properties, then select Screen Saver). If your
new screen saver does not appear in the list of available screen savers, use the Windows Find File option
to locate the .SCR file you created. Move it into your Windows directory then make it your current screen
saver as previously described.



Cancel "forgets" every change on all property sheets that you have made since the last time you hit
Apply. (Or since you came into the properties sheet if you never clicked Apply.)



Choose Color dialog box

Choose the color you want to be the background.



Choose Font dialog box

Choose the font you want your text to appear in. If you are sending the final screen saver to someone
else, and the font you choose here is not installed on their system, Windows will choose the best font it
can and will substitute it. If the look of the font is important, then make sure the Use Exact Font check box
is turned on.



Clear Segment (Edit menu)

Use this command to clear the current segment of all graphical content. This command is unavailable if
you are at the End of List.

Shortcuts

Tool bar:
Keys: SHIFT+ENTER



The Clear Segment Button makes all the settings in the Graphic, Text, Background, Audio and Duration
fields revert to their default state.



Clips
A clip is a run of segments that is always played in order. Thus, a simple screen saver that begins at
segment 1, goes to segment 2, segment 3 etc. until it reaches the last segment is actually a single clip.

After the last segment of a clip is played, the first segment of a different random clip is then started. The
simple screen saver mentioned above has no other clips to choose from, so it plays the same one again
from the beginning.

Lastly, no clip will be repeated until every clip has been played once. So if you have 20 clips, each one
will be played in a random order without repeating any one. Then it will again play all 20 clips in a random
order without repeating them, etc.

— Clip Duts—|

To make a clip, darken the clip dot on the left side of the desired starting segment and the clip dot to the
right side of the ending segment - not the ones in between. If the dots on both sides of a segment are
dark, then you've made a single segment clip. You have to make sure that all the settings in the starting
and ending segments make sense when they follow or precede any other clip since you don't know what
order they will be played in.

The very last clip dot in your screen saver will always be dark The very first clip dot can be dark or light
and controls the final clip feature - the Intro clip. The Intro clip is a clip that is played once at the beginning
of the screen saver and then never played again. If the first clip dot is white, then everything from
segment 1 up to the first black clip dot is an intro clip. (In the simple screen saver, the single clip is
actually an intro clip - it is played repeatedly since there is nothing else to play!) If the first clip dot is dark,
then the the first clip will be treated like any other clip and played randomly.



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the document
Control menu closes only one window at a time. You can close all windows at once with the Close
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window
ALT+F4 closes the window or dialog box



Color Considerations

The most important thing to consider when creating your screen saver is that if you give your screen
saver away, you do not know what color resolution the user will be running under! All screen savers will
look pretty much alike when run on true (16 million) or high (65 thousand) color systems. And the only
way a screen saver can look good on a 16 color system is if all the graphics were created using the
standard Windows 16 color palette. Which leaves 256 colors...

In general, you need to support 256 colors if you are going to allow your screen savers to get out into
general circulation since a large number of systems still only support 256 colors. High color or true color
graphics can look pretty bad under 256 colors if you use the wrong settings You can still use high color or
true color graphics and get good results - you just have to understand what's going on.

IF YOU WORK ON A 256 COLOR SYSTEM...

...when you are editing and previewing your screen saver, you are in a general rainbow palette. Your final
screen saver will probably look much better than this! The only way to know for sure is to build it and test
it.

IF YOU WORK ON A HIGH COLOR OR TRUE COLOR SYSTEM...

...what you see when you edit and preview your screen saver is exactly what the final screen saver will
look like - when run on high color or true color systems! The only way to know how good or bad it will look
on a 256 color system is to build it, change your system's color depth to 256 colors and then run your
screen saver.

IF YOU WANT TO SUPPORT ONLY HIGH COLOR OR TRUE COLOR SYSTEMS...

...then use the General Rainbow (Static) option when building your screen saver. No palette calculations
are made and the build is not slowed down at all. This will probably look bad if it is ever run on a 256 color
system!

IF YOU WANT TO SUPPORT 256 COLOR SYSTEMS...

...then use either the per Segment (Dynamic), per Clip (Dynamic) or Global (Static) settings during the
build. The per Segment (Dynamic) setting should be used only for true slide shows; that is, a series of
single images displayed one at a time. You should fade each slide to black before going to the next
image, or you will get a palette flash between segments.

In all other cases, the Global (Static) setting is the preferred one - you'll get the best looking screen saver
but it takes longer to build. If your screen saver has high color or true color graphics in it, it will look good
on 256 color systems and will look best when run on high color or true color systems.

THE DECREASE HIGH COLOR DEPTHS CHECK BOX...

...has two major functions. Using this makes screen savers look exactly the same on 256, high color and
true color systems, and it will look better on 256 color systems if you have high or true color images in
your screen saver. It saves on the final screen saver size if you have many true color images in your
screen saver. Usually it doesn't look too bad, so just check it out and see...

WORKING WITH PHOTOS...

...scanned-in photos are usually high or true color images - and are frequently JPGs, so the Use Image
Compression setting won't affect them too much. However, it seems that having the Decrease High
Depths check box on and the Use Image Compression off yields the best results for viewing on 256 color
systems.



A FINAL COLOR NOTE...

If a system is running with 256 color depth and has a web browser open to a page containing an
animating GIF or banner ads that are getting swapped out, when a screen saver kicks-in it will look fine
until the web browser updates its page. The browser then takes control of the palette and ruins the look of
the screen saver. The browser never "tells" other applications that it has changed the palette, so the

browser is at fault! The only solutions are to be running under high or true color, or not to have a web
browser open...



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is unavailable if there is no
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Er}
Tool bar:
Keys: CTRL+C



Creating New Graphics and Animations

If you have an art program or a scanner, you can create new graphics for Screen Saver Studio
Deluxe. You just need to know and keep in mind a few technical details.

The first thing to consider when making graphics that will be moved around on the screen is that
smaller is better. Make them just large enough to get the desired effect across. This is both for memory
usage as well as the fact that moving full screen images around is inherently slow.

The next thing to remember is to be careful when using true black (color zero). True black can be
made transparent, so a white disk surrounded by black can be made to look like a disk moving across the
background. If you put another black disk inside the white disk, it will look like a doughnut because the
background will show through the hole. If you want a white disk with a black center that stays black, you
need to make the center disk "not quite black". i.e. RGB values of 12,12,12 or a very deep purple, etc.

The final thing to remember deals with scanning in photos. In general, when using a scanner, 72 dpi
produces acceptable results, though it's a function of your desired screen size and the area being
scanned... If you have a 5 inch wide photo, it will be 360 pixels wide when scanned at 72 dpi. (5 inches x
72 dpi = 360 pixels.) This will be just over half of a 640x480 screen. If you scan the same photo at 300
dpi, then it will be 1500 pixels wide! If you just want to scan a 1 inch section of the same photo, then scan
it at 300 dpi so the result will be 300 pixels.

Animation files (ANM) are single files that contain many images. These images are displayed one
after the other in the same segment - thus giving the impression of movement. You can download
animations from www.screensaverstudio.com or you can use ANIMCOMP? to create your own. The
instructions for Animcomp are given when you run the program, but the basic rules are:

1. You have to have BMPs.

2. The BMPs must be the same number of colors.

3. The BMPs must be exactly the same same width and height.

4. The BMPs must be in the same encoding scheme - either RGB or RLE.

5. The BMPs must be named in sequence with a root name and digits that increase. Something like
STARO01.BMP, STAR02.BMP... STAR11.BMP.

6. The BMPs must all be in the same directory.

When you run Animcomp, you will be asked for a file to load. Select any frame of the series and it will find
the lowest numbered one and turn it and the rest in sequence into an ANM file!



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Tool bar: il
Keys: CTRL+X



Decrease High color command (File menu)

This option should be used if you are using high color or true color graphics and you want your output
to look good on 256 color systems. It reduces all graphics to 256 colors when they are placed in the
screen saver which saves a lot of space. This has the effect of ensuring that the screen saver looks the
same on all 256, high color or true color systems, but the drawback is that on high color or true color
systems, the graphics won't look quite as good.

This command is also available as a check box on the Build Screen Saver dialog. However, if you change
the state of the check box here, it can take a long time for all the graphics to be converted. It's much
better to plan ahead and set this option in the File menu before you begin a new screen saver.



Use Prior Segment Values makes every setting in the currently selected property sheet exactly the
same as the settings in the previous segment's dialog. A very useful way to recover from changes that
didn't quite work the way you wanted...



Delete Segment (Edit menu)

Use this command to delete (remove from the list) the current segment. This command is unavailable if
you are at the End of List or if you have only one segment in the list.

Shortcuts

Tool bar:
Keys: DELETE



Deleting Graphics in Segments

To delete EVERYTHING in a segment, click on that segment in the main menu then press
SHIFT+ENTER. (Or go to Edit|Clear Segment.). This clears all of the segment's contents - the graphics,
background, audio, text and timing to their default values. If you want to delete the graphics and ONLY
the graphics in a segment, you have to edit the proper segment, go to the graphics tab, and then "by-
hand" select each graphic slot and press Clear.



Deleting Segments

To delete a segment, simply click on that segment from the main menu and press Delete or click the

Delete Segment Icon in the Tool bar (



Distributing

Your purchase of Screen Saver Studio Deluxe grants you the right to freely distribute the files you
create to friends, family members, business colleagues, clients, and customers as long as there is no
charge. If you wish to sell your screen savers, you must obtain a licensed version of Screen Saver Studio
Deluxe. Visit or call 1-800-831-2694 for more information.



Continuously Loop. After ALL graphics and text have fully faded onto the screen, just keep doing what
they're doing. They never fade out (even if set to do so) and the segment never ends.



Stop after x graphic cycles in slot y. After ALL graphics and text have fully faded onto the screen, wait
until the graphics in the specified slot have exited or bounced off the screen edge this many times, then
begin fading out all the graphics and text. When the last one disappears, the segment ends.



Stop after x text cycles. After ALL graphics and text have fully faded onto the screen, wait until the text
block has exited or bounced off the screen this many times, then begin fading out all the graphics and
text. When the last one disappears, the segment ends.



Stop after x seconds. After ALL graphics and text have fully faded onto the screen, wait this many
seconds then begin fading out all graphics and text. When the last one disappears, the segment ends.
The maximum is 60 seconds. If you need longer than this (to delay as long as a MIDI song, for example),
duplicate the segment as many times as necessary, setting the Fade In only on the first segment and the
Fade out only on the last one.



Clear All command (Edit menu)

<< Write application-specific help here. >>



Clear command (Edit menu)

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out. The Repeat menu item changes to
Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Replace command (Edit menu)

<< Write application-specific help here. >>



Edit Segment (Edit menu)

Use this command to edit the currently selected segment. This command is unavailable if you are at the
End of List. Whenever you are editing or previewing a segment, all graphics will appear in the rainbow

palette. See Building New Screen Savers (.SCR files) or Programs (.EXE files) for more information on

palettes.

Shortcuts

Tool bar: EI

Keys: ENTER



Edit menu commands

The Edit menu offers the following commands:

Undo Undoes the last Edit action.

Cut Deletes data from the document and moves it to the clipboard.
Co Copies data from the document to the clipboard.

Paste Pastes data from the clipboard into the document.

Paste Insert Inserts data from the clipboard into the document.

Edit Segment Edit the contents of the selected segment.

Clear Segment Clear the contents of the selected segment.

Delete Segment Removes the currently selected segment.

Insert Segment Inserts a new segment in front of the selected segment (duplicates the contents of the previous
segment).

Toggle Clip Allows you to define clips.

Marker



Editing Segments

To edit a previously created segment, simply double-click on that segment from the main menu (or select
it and press Enter). You'll see the segment properties sheet. A tab other than Graphic may be highlighted
when you get there - it remembers the last accessed one and keeps it selected.

Click on the graphic below for more help.
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Element (View menu)

Determines which graphical element (graphics 1-10 or text) will be displayed for each segment in
the segment list.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you
closed. Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Screen Saver Studio Deluxe session. You can also use the Close
command on the application Control menu. Screen Saver Studio Deluxe prompts you to save
documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



New command (File menu)
Use this command to create a new document in Screen Saver Studio Deluxe.
You can open an existing document with the Open command.

Shortcuts

Tool bar: QI
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing document.
You can create new documents with the New command.

Shortcuts

Tool bar: EI
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open. This box lists files with the extension you select in the
List Files of Type box.

Drives

Select the drive in which Screen Saver Studio Deluxe stores the file that you want to open.
Directories

Select the directory in which Screen Saver Studio Deluxe stores the file that you want to open.
Network...

Choose this button to connect to a network location, assigning it a new drive letter.



Save As command (File menu)

Use this command to save and name the active document. Screen Saver Studio Deluxe displays the
Save As dialog box so you can name your document.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name. A filename can contain up to eight
characters and an extension of up to three characters. Screen Saver Studio Deluxe adds the
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Save command (File menu)

Use this command to save the active document to its current name and directory. When you save a
document for the first time, Screen Saver Studio Deluxe displays the Save As dialog box so you can
name your document. If you want to change the name and directory of an existing document before you
save it, choose the Save As command.

Shortcuts

Tool bar: EI
Keys: CTRL+S



File menu commands
The File menu offers the following commands:

New Project Creates a new project.
Open Project Opens an existing project.

Save Project Saves an opened project using the same file name.
Save Project Saves an opened project to a specified file name.
As

Decrease High  Used to make a screen saver look better on 256 color systems when using true
color Depths color or high color images.

Use Image Used to convert graphics internally into JPGs instead of BMPs.

Compression

Build SCR/EXE Build and save the current document as a .SCR or .EXE file.

Exit Exits Screen Saver Studio Deluxe.



Files Supported

Screen Saver Studio Deluxe can work with a variety of bitmap and vector graphics. Formats ranging from
BMP, JPG, PCX, WMF and more can be used to make your screen savers. Screen Saver Studio Deluxe
takes these graphics and converts them into a standard format inside the screen saver. Unless Use
Image Compression is on, every format except BMPs will be converted into temporary files on your hard
drive. In order to save on working hard drive space and speed up loading time, you should try to work with
BMPs as much as possible. When Use Image Compression is on, the graphics will be stored as JPGs.

The complete list of graphics files supported is:

AVI, BMP, DIB, ANM, CMP, CAL, IMG, PNG, DIC, TIF, JPG, ICA, JFF, JTF, PCT, MAC, MSP, PCD, PCX,
PSD, EPS, RAS, TGA, TIF, WMF, FXS, WPG, ICO, CUR.

Screen Saver Studio Deluxe opens most of the sub-types of these files.

AVI files are a common file format for video animations. Screen Saver Studio Deluxe can import most AVI
files, but they can only be placed in graphic slot 1. You may experience some palette conflicts on
computers running in 256 color mode if you have other graphics or a background in effect while an AVl is
playing. While it is possible to move an AVI around the screen while it is playing, it is not recommended.
AVl files are packaged with the screen saver so be careful - it is easy for the file sizes to become large
with AVI files! The computer on which the screen saver will run must have an AVI player installed in order
to function properly. Windows 95 systems have one built in, Windows 3.x users will need something like
Video for Windows. (Available at www.microsoft.com).

BMP is a standard format with two common sub-types - RGB encoded and RLE encoded. If your paint
program gives you a choice, use RLE since it usually makes the finished screen saver smaller.

The ANM file is an animation file created with ANIMCOMP, the beta program included with Screen Saver
Studio Deluxe*. Animations created by other programs with an ANM extension will not work. We
recommend you keep your animations in a single directory so you don't get confused.

Note: Graphics in a lossy format (JPG and PNG for example) have a compression feature that often gives
incorrect results when working with the transparent black portion of a graphic. This is because the file
compression algorithm /oses information from the original to obtain greater compression, and it frequently
does this by saying that all near blacks become the same black since the human eye can't distinguish the
difference anyway. Unfortunately, Screen Saver Studio Deluxe can and does need a specific range of
black to work with to make masks correctly. We recommend that you load these format graphics in a paint
program and make sure that the masked areas are the correct black, then save them out to another
format - BMP for example. The Use Image Compression setting can ruin transparent blacks, so use it
only when doing so can't have adverse affects!



Find dialog box

<< Write application-specific help here. >>
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Glossary

>

Animcomp: A separate beta-program included with Screen Saver Studio Deluxe that allows you to take
identically sized and formatted BMP graphics and turn them into an ANM file*.

ANM: An animation file created with Animcomp. These files play a sequence of images in order within a
single segment. ANM files created with other programs will not work in Screen Saver Studio Deluxe!

Audio: Sound of any supported format - WAV or MIDI.

AVI: A common form of graphic movie. AVI's can only be played in Graphic Slot 1. The user of the screen
saver needs an AVI player on his system!

Background: The mat on which all objects are placed. All other objects are above the background.

BMP: A standard Windows graphic format. If your paint program supports it, when you create new
graphics you should save them as RLE encoded since this usually makes your final screen saver smaller.

Bounce: A special object motion where the object bounces off the edge of the screen instead of moving
off of the screen.



Build: To take your raw SSP file and turn it into an SCR or EXE.

C

Clip: Aclip is a run of segments that plays from the first segment of the clip to the last segment of the clip.
When the last segment is played, a different clip is chosen at random to be played.

Clip Marker (or Clip Dot): The graphical indication of where a clip begins and ends. A dark dot indicates
both the beginning and end of a clip; a light dot shows the segment is an internal part of a clip.

Compression: Making your screen saver smaller so it is easier to distribute.

D

Distribution: Giving your screen saver away for free! If you want to sell your creations, call 1-800-831-
2694 and ask about the Professional version.

Duration: How long the movement portion of a segment lasts. It can be set to last a certain number
of seconds, or by how a certain object moves.

(Dynamic) per Segment or per Clip: Settings designed for slide shows that calculates a palette
for every segment or each clip. You should fade each slide to black before going to the next image, or you
will get a palette flash between segments.

E
Effects: The different ways objects can Fade In or Fade Out during a segment.

EXE: An executable program. Screen Saver Studio Deluxe can build a Presentation EXE, or a self-
installing screen saver EXE.

F

Fade In: The portion of a segment where objects enter the screen. There are a variety of effects to
choose from.

Fade Out: The portion of a segment where objects leave the screen. There are a variety of effects to
choose from.

G

General Rainbow (Static) Palette: A general palette used while building and previewing your screen
savers. It makes a fairly good approximation for most graphics, but is bad for photographs.

Global (Static) Palette: A setting that takes all the graphics from the entire screen saver and makes the
single best palette. The results are usually very good. There is never a palette flash between segments,
but it can take a while for the palette calculation during the build.

Graphic: The main object in Screen Saver Studio Deluxe. Many graphic formats are supported, but they
are all turned into a standard format in the final screen saver.

Graphic Slot: Graphics in a segment are assigned to one of ten slots to keep track of them. The major
function of a slot is determining how objects pass over each other on screen.



H

High Color: Also known as 16-bit or 65 thousand color, this is a video mode that displays 65,536 colors.
(Also used to describe 15 bit color, a mode that displays 32,767 colors.)

Icon: A little picture that is associated with the file you create. It is also displayed in the set-up box of a
screen saver.

Icon Editor: Accessed from the Tool menu, this is a program that allows you to create icons.

Intro Clip: If the very first clip dot is light, the first clip will be played only once when the screen saver
begins. It will not be played again.

J

JPG: A popular, lossy graphic format. Because of the compression method used, these may not work
properly with transparent black settings. They will become larger when internally stored in screen savers.

K

L

Layer: A graphic slot functions like a layer in other programs, but the top most layer is always slot 1 and
the bottom layer is slot 10.

Lossy: A compression scheme that sacrifices information for size reduction. Usually used on graphics
(like JPG and PNG) under the theory that the human eye can't detect the difference between the original
and the compressed graphic. Unfortunately, Screen Saver Studio Deluxe can run into trouble with
transparent black settings when using lossy graphic formats.

M

Mask: A way of letting the background show though a graphic. All pixels of a certain color are defined to
be transparent. In Screen Saver Studio Deluxe, the mask color is always any black with RGB values of
12,12,12 or less. Thus, in the graphic of a dough-nut, you'd make the hole the mask color so you could
see it was a hole.

MIDI: A music format where instruments and notes are defined as numbers. Much smaller in size than
WAVs, MIDIs will play on most properly installed sound cards. However, songs may not sound the same
on different systems.

Movement: The main portion of each segment, this is where objects move around the screen. You can
set the speed and direction of movement.

o

Object: Either a graphic or a block of text. Objects are the "actors" in your screen saver "movie".



P

Palette: The specific 256 colors a segment uses out of all the millions of available RGB colors Only a
concern on 256 color systems since true color and high color systems always have all the colors and 16
color systems all use the same 16 color palette.

Palette Flash: An annoying, often psychedelic distortion of colors that briefly occurs on 256 color systems
when displaying a new segment that uses a different palette of colors.

Password: An access feature of many screen savers. When the screen saver is exited, you are asked for
a password. If you do not enter the right one, you cannot get onto the system. It prevents unauthorized
users from using your system while you are away. It is set in the setup dialog box. If you use one, don't
forget it or you won't be able to get on your system either!

per Segment (Dynamic): A setting designed for slide shows that calculates a palette for every
segment. You should fade each slide to black before going to the next image, or you will get a palette
flash between segments.

Pixel: The basic unit of the screen, each "dot" on the screen is one pixel. A 640x480 screen resolution
means you can see 640 pixels across and 480 pixels up and down.

PNG: A lossy graphic format. Because of the compression method used, these may not work properly
with transparent black settings. They will become larger when internally stored in screen savers.

Presentation EXE: A stand-alone program. It must be run like any other program - it does not run
automatically like a screen saver. It is exited by a key press.

Preview: A way to look at your screen saver before building it. You can watch the segment number to see
where things go wrong. The preview uses the rainbow palette.

Q

R

RGB: An acronym of Red, Green, Blue. It's a way of specifying a color by each of the three values which
run from 0 (dark) to 255 (bright). Black is 0,0,0; white is 255,255,255, bright blue is 0,0,255 etc.

S

SCR: The file extension of screen saver files.

Screen Resolution: The width and height of your screen as measured in pixels. Common resolutions are
640x480, 800x600, 1024x768, and 1280x1024 but more exist. In fact, some settings can be larger than
your screen can show - "virtual" screen sizes - but Screen Saver Studio Deluxe will still work! But
remember that when on a virtual screen, you can't scroll around to see the action which may be
happening off the screen!

Screen Saver: A special program that is run automatically after a predefined length of time has passed
with no input to your computer. Any key press or mouse movement exits the program. Originally designed
to keep your monitor's screen from getting burned by constantly displaying the same thing for long
periods of time, screen savers have become fanciful, fun, whimsical programs that amuse or break up the
work-day monotony.

Segment: The basic unit of a Screen Saver Studio Deluxe screen saver. Each segment has three parts: A



beginning where objects Fade In, a middle where objects Move, and an end where objects Fade Out.
Objects can be moving while fading in and out, and they can be stationary during the motion portion.

Slot: Graphics in a segment are assigned to one of ten slots to keep track of them. The major function of
a slot is determining how objects pass over each other on screen.

Sound: Either a sound (WAV) or song (MIDI). Only one sound can be played per segment, though it can
be played multiple times

Speed: The number of pixels that an object moves every update. Speed can range from 0-50.

SSP: Screen saver project. The file that tells Screen Saver Studio Deluxe where to find and how to move
all the objects in your screen saver.

Sticky: A special background where objects leave a trail behind when they move.

T

Text: An object that displays a block of text you enter. You can set the font, style, color and size of the
text. You can have one text object per segment. The text object in all other respects acts like a graphic.

Tiling: Drawing the same graphic side by side and above and below itself to fill a large area. If care is
taken, the edges where the graphics abut can be seamless. Vertical or horizontal lines are the result of
improperly designed tiles.

Transparent Black: A check box setting that allows graphics or text to be masked on to the screen.

True Color: Also known as 24-bit or 16 million color, this is a video mode that displays 16,777,216 colors.

U

Update Rate: How often Screen Saver Studio Deluxe redraws every object on the screen. Measured in
milliseconds (thousandths of a second). The default of 200ms means that every 0.2 seconds objects will
be moved and redrawn.

Use Exact Font: A text setting that turns the text in a segment into a graphic - ensuring that all users will
see the font and style used no matter what fonts they have on their system.

Use Image Compression: A setting that forces all graphics to be internally stored as JPGs. This can
result in great size savings but sometimes with a loss of image quality.

v

w

WAV: A sound format which digitizes an actual sound as a long string of numbers. All systems with sound
cards should be able to play WAVSs.

X

X Coordinate: In the Cartesian coordinate system, the X-axis is the horizontal axis. It is positive (+) to the
right of center and negative (-) to the left of center. In Screen Saver Studio Deluxe, the center is defined to
be the very center of the visible screen.



Y

Y Coordinate: In the Cartesian coordinate system, the Y-axis is the vertical axis. It is positive (+) above

center and negative (-) below center. In Screen Saver Studio Deluxe, the center is defined to be the very
center of the visible screen.

y4

Zoom: A fade effect where the object grows from or decreases to a point.



The Bounce check box allows graphics using user defined motion to bounce off the edge of the screen.
Be aware that when a new segment is begun, a user defined bouncing graphic will start the segment by

moving in the user defined direction! It may therefore seem to reverse direction in the middle of the
screen; but this is what's supposed to happen!




The Graphic Clear Button changes the graphic in the selected slot to <none>. It does not change any
other settings.



Graphic Definition
The Define Graphic settings are in effect for both BMPs and ANMs. The controls in this box change

slightly depending on the motion selected as shown below. If the Motion is User Defined, you will see the
box on the right; any other motion gives the box on the left.

Click below for more help.
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The Effect slide bar changes the rate at which the fading effect occurs - at the slow end it will take a
lonnnng time for the graphic to fade; at the high end it is almost instantaneous. It affects both the In and
Out effects.



The Graphic In effect determines how the graphic will arrive on the screen. The options are:

Zoom- the graphic begins as a point and becomes larger until it is full size. Note! Some video drivers will
make zooming graphics look almost black until they are full-size. This is not a problem with Screen Saver
Studio Deluxe but rather with the graphics card.

Random Blocks- random blocks appear until the entire graphic is displayed. The effect speed
determines the size of the blocks - the faster the speed, the larger the blocks.

Horizontal Expand- the center-line of the graphic appears then it expands simultaneously to the top and
bottom.

Vertical Expand- the center-line of the graphic appears then it expands simultaneously to the left and
right.

Horizontal Scan- the top or bottom of the graphic appears, then it builds to the other edge.

Vertical Scan- the left or right of the graphic appears, then it builds to the other side.

Instantaneously- the entire graphic appears at once.



The Motion pull down menu determines how the graphic acts on-screen:

user defined- the user gets custom control over the movement.

bounce- the graphic moves around the screen and when it reaches an edge, it bounds off in the opposite
direction.

left, right, up or down- the graphic moves across the screen in the indicated direction. After it exits the
screen, it reappears coming in on the opposite edge in a random location.

stationary- the graphic stays where it is placed. Animations, however, could still appear to move around
in a limited area if they were designed that way.



No. of Graphics sets the number of this graphic that will be placed on-screen. The range is 1 to 50. All of
these graphics will initially be positioned randomly, except the first one which strictly obeys the Starting
Graphic Location rules. For moving graphics, the first one will move according to the speed bar, all others
will move randomly at the same speed or slower. (For User Defined motion, all graphics move at the user
defined slope.)



The Graphic Out effect determines how the graphic will leave the screen. The options are:

Zoom- the graphic decreases in size until it disappears. Note! Some video drivers will make zooming
graphics look almost black unless they are full-size. This is not a problem with Screen Saver Studio
Deluxe but rather with the graphics card.

Random Blocks- random blocks disappear until the entire graphic is gone. The effect speed determines
the size of the blocks - the faster the speed, the larger the blocks.

Horizontal Contract- the top and bottom lines of the graphic disappear until they meet in the middle.
Vertical Contract- the left and right sides of the graphic disappear until they meet in the middle.
Horizontal Scan- the top or bottom of the graphic disappears, then it erases to the other edge.
Vertical Scan- the left or right of the graphic disappears, then it erases to the other side.
Instantaneously- the entire graphic disappears at once.

None- the graphic is not erased from the screen. However, other graphics moving over it will erase the
part they move over until it is eventually erased.



The graphic preview window shows a resized version of the graphic in the highlighted slot. The path
name (or as much as can fit) appears above it.



There are 10 graphic slots for graphics in each segment. The slot a graphic is in affects how it acts on
the screen. Graphics in slot 10 will always be at the lowest depth (just above the background) whereas
those in slot 1 will always be on top (just under text.) When two graphics pass over each other, the one in
the lower numbered slot (towards the top of the list) will be above the higher numbered one.

Double-click on a graphic slot to call up the dialog box to select a graphic or animation. The selection
dialog has a small thumbnail of the file currently highlighted. This can be turned off in the View menu if it
is taking too long for your system to display the preview.

You can drag a graphic from one slot to another by clicking on a slot and holding the mouse down while
moving. This swaps adjacent slots. All the information associated with the slot is moved with the graphic!
If you hold down the SHIFT key first, you will drop a copy of the graphic you were dragging when you
release the button.

AVls are a common format of video. You can use an AVI as a graphic - but only in slot 1. When you select
an AVI for a segment, you will see a check box labeled "Play AVI full Screen." If this is checked, the AVI
will be stretched so that it fills the entire screen - no matter what resolution the screen saver is run under.
When it is checked off, the AVI will play in its created dimensions.

AVls are always the top-most object - they appear even above text! If you are playing an AVI full
screen (or an AVI that takes up the whole screen) then you will see nothing but the AVI.

You may experience some palette conflicts on computers running in 256 color mode if you have other
graphics or a background in effect while an AVI is playing. (This can be stopped if the other graphics and
background are in the Windows 16 color palette.) While it is possible to move an AVI around the screen
while it is playing, it is not recommended. When in 256 color mode, AVIs can cause a palette flash before
and after the AVI.

AVI files are packaged with the screen saver, so be careful - it is easy for the file sizes to become large
with AVI files! The computer on which the screen saver will run must have an AVI player installed in order
to function properly. Windows 95 systems have one built in, Windows 3.x users will need something like
Video for Windows. (Available at www.microsoft.com).



The Speed bar determines how fast the graphic moves across or around on your screen. The speed
number is actually how many pixels the graphic moves every update. Thus, at the default Update Rate of
200ms, 5 updates occur every second. A graphic with a speed of 10 will therefore move 50 pixels every
second.



The Graphics Starting Values are dimmed and can't be accessed unless Pixel Offset or % Offset is
chosen for the particular axis. Values can run from -9999 to 9999.



The Graphic Starting Point is broken into X and Y coordinates for maximum flexibility. Usually you will
have both axes set to the same thing, but they can be different. The options are:

Keep Old- begin at the same location the graphic ended at in the previous segment. This is needed to
maintain smooth motion of graphics from segment to segment. If there was no graphic in the previous
segment, a Random location is used instead.

Preset- uses standard starting locations based on the selected motion of the graphic. Bounce generates
a Random location that keeps the graphic completely on the screen. Stationary is centered on the axis.
Left, Right, Up or Down motion puts the starting location just off the edge of the screen. User defined
motion graphics use a random starting location that is completely on the screen.

Random- places the center of the graphic somewhere on the screen. Thus, the graphic can start partially
off the screen.

Left Side or Right Side on X axis, on the Y axis Top or Bottom- puts the graphic just off the indicated
edge of the screen.

Pixel Offset- starts the center of the graphic the specified number of pixels from the center of the screen.
% Offset- starts the center of the graphic the specified percentage of the screen resolution from the
center of the screen.




The text Keep Black Transparent check box is normally unchecked. It causes all black pixels with an
RGB value of 12,12,12 or less to be treated as see-through. Turn this on when you want to "move objects
over each other or across a non-black background.

Note- the 12,12,12 value is used to circumvent problems some video cards have with "near black" colors
acting like 0,0,0 when you want them to be solid. This should work on most systems.



The Transparent Fade check box here is similar to the Keep Black Transparent box. You normally want
this on unless you are working with only one graphic on a black background.



The heart of user defined motion is an understanding of the X-Y coordinate system. The center of the
screen is 0,0. X is the horizontal axis; it increases to the right (+) and decreases to the left (-). The Y axis
is the vertical axis; it increases to the top (+) and decreases to the bottom (-). By setting the sliders to the
proper numbers, you can make an object move in any desired direction.

The X and Y Speed numbers represent how many pixels the graphic moves every update. Thus, at the
default Update Rate of 200ms, 5 updates occur every second. A graphic with an X-speed of 10 and a Y
speed of 3 will therefore move 50 pixels to the right and 15 pixels up every second.



The Help button brings up context-sensitive help dialogs.



Context Help command

?

Use the Context Help command to obtain help on some portion of Screen Saver Studio Deluxe. When
you choose the Tool bar's Context Help button, the mouse pointer will change to an arrow and question
mark. Then click somewhere in the Screen Saver Studio Deluxe window, such as another Tool bar
button. The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Help menu commands
The Help menu offers the following commands, which provide you assistance with this application:

Getting Started  Runs a presentation that guides you through building a screen saver.

Tutorial (If the file is not present, loads the appropriate help section.)

Index Offers you an index to topics on which you can get help.

Using Help Provides general instructions on using help.

Screen Saver Tries to connect to the www.screensaverstudio.com page concerning
Studio News updates, patches, new version, etc.

and Info

Distributing Tells you how to give away your screen savers.

About Displays information about Screen Saver Studio Deluxe.



Icon Editor

Icon Editor is an add on program that allows you to create icons for the screen savers you create. By
selecting the Icon Editor icon from the tool bar (or selecting Tools|Icon Editor from the Menu Bar), you
activate this program.



Index command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to
step-by-step instructions for using Screen Saver Studio Deluxe and various types of reference
information.

Once you open Help, you can click the Contents button whenever you want to return to the opening
screen.



Insert Segment (Edit menu)

Use this command to insert a new segment. If it is not the first segment in the list, then the contents of
the previous segment will be copied to the new segment. This command is unavailable if there are
already 1000 segments in the list (1000 is the maximum).

Shortcuts

Tool bar:
Keys: INSERT



Inserting Segments

You can create complex and interesting screen savers with Screen Saver Studio Deluxe by creating
up to 1,000 different segments that "play" in segment order (1-1,000) on your screen. To insert or add a
segment to your screen saver document, return to the main program interface (if necessary) and click on
the segment that will follow or come after the new segment you want to insert. If you want the new
segment to be last, click on End Of List before inserting.

To create a new segment, press Insert on your keyboard or click the Insert New Segment Icon in the
En
Tool bar (). NOTE: each time you insert or add a new segment with this icon or with the Insert key,
the new segment is automatically filled with the contents of the previous segment.
If you want to insert a new segment that is a duplicate of some other segment in your document,
simply select that segment and copy it to the clipboard by pressing Ctrl+C or clicking the copy icon in the

Tool bar (). Select the segment that will follow the segment you wish to insert, then click the Insert
New Segment And Paste Icon in the Tool bar (

) or select Paste Insert from the Edit Menu.



Installation

Before You Install:

1. Close all applications, including all screen saver programs that may be running in the background.
2. Check your hard disk space to ensure that you have the space available for the minimum installation.
3. If you are logged onto a network, log off.

To Install:

WINDOWS 95

1. Click the Windows 95 Start button.

2. Select the RUN option.

3. Type DASETUP in the COMMAND LINE field. (where "D" is the letter of your CD-ROM Drive)

4. Click "OK" and follow the on-screen prompts. Screen Saver Studio Deluxe will be installed in the
directory \program files\ssstudio (or you may choose another directory during the installation process).



Introduction

Welcome to Screen Saver Studio Deluxe!

Screen Saver Studio Deluxe is an exciting new utility for Windows that enables computer users--no
matter what their level of computing expertise--to create professional-looking screen savers for home or
office. If you can click your mouse you can create a screen saver that your friends, associates, or clients
will love. To get you started we have provided you with useful sets of graphics, animations, and sounds’*.
But if you have the artistic ability to create your own graphics, you will have even more design options.

Screen Saver Studio Deluxe gives you all the tools necessary to create your own screen savers! Anything
you can imagine can be created using the simple interface of Screen Saver Studio Deluxe! With Screen
Saver Studio Deluxe, you can:

Import many different graphic formats (AVI, ANM, BMP, CUR, EPS, ICO, JPG, PCX, PSD, TIF,
TGA, WMF, WPG and more) and animate them in many different ways

Import any WAV or MIDI file to add sound to your screen saver

Add your own text easily

Add transition effects for graphics and text

Save your screen savers to give to family members, friends or business associates. No
additional software is needed to run the screen savers you create with Screen Saver Studio
Deluxe!

Children and adults will quickly create screen savers with the easy to use interface of Screen Saver
Studio Deluxe. Just a few clicks of the mouse and you are on your way to making a screen saver
creation. Advanced users will enjoy the flexibility and many features of Screen Saver Studio Deluxe as
well.



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon E on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a
document using your application.

If your application supports multiple document types and you want to have a distinct help topic for each,
then use the help context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard.
Alternatively, run MAKEHM as follows:

makehm IDR_HIDR _,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help
context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first
document type supported by your application. AppWizard produces an alias in the .HPJ file for your
application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that document type. >>



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with
the arrow keys.

Note: This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Next Pane

<< Write application-specific help here. >>



Next Window command (document Control menu)

Use this command to switch to the next open document window. Screen Saver Studio Deluxe
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



No Help Available

No help is available for this area of the window.



No Help Available
No help is available for this message box.
<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx

values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value. For
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>



OK accepts all the changes you've made and leaves the properties sheet. Returns you back to the main
screen.



Opening Previously Saved Documents

Save your current screen saver document (if necessary), then press CTRL+O or choose Open in the
File Menu. Locate the previously saved screen saver document you wish to open and press OK.

If you are working on a screen saver and wish to get rid of the changes you've made in a session, you
can not just reload the file you want - you have to do a File|New and then a File|Open.



Palette: The specific 256 colors a segment uses out of all the millions of available RGB colors Only a
concern on 256 color systems since true and high color systems always have all the colors and 16 color
systems all use the same 16 color palette.



Palette Flash: An annoying, often psychedelic distortion of colors that briefly occurs on 256 color systems
when displaying a new segment that uses a different palette of colors.



Paste Insert command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is
unavailable if the clipboard is empty or if there are already 1000 segments in the list (1000 is the
maximum).

Shortcuts

Tool bar:
Keys: CTRL+A



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is
unavailable if the clipboard is empty.

Shortcuts

Tool bar:
Keys: CTRL+V



Prev Pane

<< Write application-specific help here. >>



Preview (View menu)

Use this command to see what the screen saver would look like if you built it right now. Whenever you are
previewing or editing a segment, all graphics will appear in the rainbow palette. See Building New Screen
Savers (.SCR files) or Programs (.EXE files) for more information on palettes.

Shortcuts

Tool bar: %I

Command bar %l

Keys: CTRL+P



Previous Window command (document Control menu)

Use this command to switch to the previous open document window. Screen Saver Studio Deluxe
determines which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



RGB: An acronym of Red, Green, Blue. It's a way of specifying a color by each of the three values which
run from 0 (dark) to 255 (bright). Black is 0,0,0; white is 255,255,255, bright blue is 0,0,255 etc.



Replace dialog box

<< Write application-specific help here. >>



Resolution (View menu)

Determines how many segments will be visible in the segment list at any given time.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or
Minimize command.



Saving Screen Saver Documents

Once you have completed your screen saver document and are satisfied with the Preview (Alt V+P),
choose Save (Ctrl+S) in the File Menu to save the document. Though it is possible to build a screen saver
module or program without saving the current document, we recommend saving every document in case
you want to change it or duplicate the effects you have achieved with different graphics. Use the Save As
command in the File Menu when you want to create a copy of an open screen saver document.



Screen Stuff

Screen Saver Studio Deluxe always treats the dead center of the screen as 0,0. The X axis is the
horizontal axis - you can move left and right along it. The Y axis is the vertical axis - you can move up and
down on it When you move up you are moving in a +Y direction, down is the -Y direction. Moving right is
+X and left is -X.

You can use the pixel offset when starting your graphics to put them in a specific location. The pixel range
in any direction is 9,999. That is, you can place a graphic anywhere from -9,999 to +9,999 pixels in the X
or Y direction. Screen Saver Studio Deluxe works with the dead center of a graphic as its reference point,
so for a graphic to be placed off the edge of the screen, for example, the center of the graphic must be
placed far enough off the screen so that none of the graphic is visible on-screen. Placing a graphic at a
pixel offset of 0,0 centers the graphic on the screen.

When you create your screen saver, you have no idea what screen resolution the final screen saver will
be running on. It could be 640x480, 800x600, 1024x768 or even higher. The right edge is +320 X on a
640x480 screen, the bottom edge is -300 Y on an 800x600 screen, the left edge is -512 X on a 1024x768
screen, etc. you need to take this into account when making your screen savers. If you place something
+400 X pixels, it may be off the screen on a 640x480 screen but visible on a 1024x768 screen!

The % Offset feature gets around the screen resolution question since it moves the center of the graphic
the designated percentage distance from the center of the screen. The edges of the screen are always
one-half of the distance of the screen resolution away from the center. Thus, +50% X will put the graphic
half-off the right edge of the screen no matter what screen resolution you are running under! (It's only half-
off the screen because the center of the graphic is placed there.)

The % offset runs from -9999 to 9999. You generally won't want to go beyond 100% in any direction since
it would take a long time for such a graphic to get on the screen!



Screen Saver Studio Deluxe Concept
SEGMENT BASED APPROACH

Screen Saver Studio Deluxe is a segment based screen saver creator program. Think of a segment
as one page. It contains the various elements that you add. Graphics, text, sounds, background elements
and the like are placed in a segment. An initial transition effect (like zoom in, random blocks, or appear
instantly), is applied along with motion (up, down, right, left, bounce, stationary). An exiting transition
effect can then be applied as well. To complete the segment, the duration is set. This tells how long a
segment will last (how long the objects will move or appear). Screen Saver Studio Deluxe supports up to
1000 segments. The screen saver you create will automatically run through the segments you create. It
puts them together to form your screen saver. Combining graphics, sounds, text, backgrounds, duration,
movements and transition effects offers almost unlimited possibilities for your screen saver creations!

Some of the best screen savers are simply one or two segments that repeat (a bouncing logo with
background images can be quite effective). One simple example would be a screen saver featuring
photos of the family pet. Each picture displayed would fill a segment. You would add various transition
effects between each segment to give a slide show appearance, but basically you would have as many
segments as you have pictures.



Click on the graphic below to get specific help. To get the full table of contents, click on the Contents
button above.
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Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars
indicate your vertical and horizontal location in the document. You can use the mouse to scroll to other
parts of the document.

<< Describe the actions of the various parts of the scroll bar, according to how they behave in your
application. >>



The Select Thumbnail Preview toggles whether or not you will see a graphic preview when you are
selecting a graphic. It is nice to see what the graphic looks like, but it may be too slow on your system
when opening large graphics or non-BMPs.




Adjusting the Timing of a Segment

As you create segments, an important consideration becomes setting how long each segment lasts. This
is an art more than a science because of the vagaries of different systems. After all the graphics and text
fade in, the segment lasts for the specified duration, then all the graphics and text fade out. You can affect
the timing in one of 4 different ways - click on the graphic below for more help.

Segment 1 |

Graphicl Text I Eackgrnundl dudio  Timing |

— Dluration of Seament [excluding fading effects]

" Stop after [10 :II graphic cycles of slot I‘I vI
= Stop after I'IEI j bext cycles

= Play forever - never do fade-out effects

— Update Rate

Update Rate IEE":I ﬂ millizeconds

Clear | Usze Prior Segment W alues |

View | 1]4 I Cancel | Apply | Help |




Show Background (View menu)

Determines whether or not each segment's background will be displayed behind whichever graphical
element you have chosen in the segment list




Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the
border you want to move.

2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note: This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Starting Screen Saver Studio Deluxe

Starting Screen Saver Studio Deluxe:

1. From the desktop, click on the START button. The START menu displays.

2. Move the cursor to the PROGRAMS option. The Program Menu displays.

3. Click on the Screen Saver Studio Deluxe program group to display the menu.

4. Click on the Screen Saver Studio Deluxe icon. The Screen Saver Studio Deluxe interface will load and

you are ready to make your own screen savers!



Switch to command (application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or close an
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following
options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not
affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap. This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Minimize command (application Control menu)
Use this command to reduce the Screen Saver Studio Deluxe window to an icon.

Shortcut

Mouse: Click the minimize icon IZI on the title bar.
Keys: ALT+F9



System Requirements

Minimum & Recommended System Requirements:

Screen Saver Studio Deluxe was designed for any system running Windows '95, Windows 98 or Windows
NT.

Recommended System Requirements are
10 Megabytes of free hard drive space (for work and project files)
SVGA graphics

Basically, Screen Saver Studio Deluxe will work on any system that can handle Windows 95! The screen
savers it creates will work on any Windows 3.x or better system! However, you can build Windows '95
only screen savers!

We've given you all the needed software to see AVIs' yourself, however, if you create a screen saver that
plays an AVI, you must be sure that the recipient has an AVI player. Windows 95 systems come with one;
Windows 3.x users will need to install an AVI player - or when the screen saver tries to play the AVI, the
screen will go black and stay that way. Video for Windows can be downloaded free from the Microsoft
web site.

For technical support information, please call 318-221-8718. When you call, have information regarding
your computer configuration available. You may also send e-mail to support@softdisk.com.



The text Bounce check box allows text using user defined motion to bounce off the edge of the screen.
Be aware that when a new segment is begun, user defined bouncing text will start the segment by moving
in the user defined direction!




The Text Clear Button deletes all the text in the text entry box. It does not change any other settings.



Text Definition

The Define Text settings allow to control your text. The controls in this box change slightly depending on
the motion selected as shown below. If the Motion is User Defined, you will see the box on the right; any
other motion gives the box on the left.

Click below for more help.
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Click in the text entry box to activate it and then enter your text. As you type, you will remain on the
same line and the text will scroll to the left. Only press <Enter> if you want two or more distinct lines of
text to appear. If you enter a long line of text, it will be clipped by the screen edges.



The Effect slide bar changes the rate at which the fading effect occurs - at the slow end it will take a
lonnnng time for the text to fade; at the high end it is almost instantaneous. It affects both the In and Out
effects.



You can control the appearance of the text by clicking on the Font... button. This calls up the standard
font selection dialog that lets you select the font, style, size, effect and color of the text.

It is important to know that Screen Saver Studio Deluxe does not incorporate the font in the actual
finished screen saver. This means that if you use a special font and then run the screen saver on a
system that does not have that font, the text will be displayed using Windows attempt to recreate the font
- and the results may not be acceptable. See Use Exact Font check box.



The Text In effect determines how the text arrives on the screen. The options are:

Zoom- the text begins as a point and becomes larger until it is full size.

Random Blocks- random blocks appear until all the text is displayed. The effect speed determines the
size of the blocks - the faster the speed, the larger the blocks.

Horizontal Expand- the center-line of the text appears then it expands simultaneously to the top and
bottom.

Vertical Expand- the center-line of the text appears then it expands simultaneously to the left and right.
Horizontal Scan- the top or bottom of the text appears, then it builds to the other edge.

Vertical Scan- the left or right of the text appears, then it builds to the other side.

Instantaneously- all the text appears at once.



The Motion pull down menu determines how the text acts on-screen:

user defined- the user gets custom control over the movement.

bounce- the text moves around the screen and when it reaches an edge, it bounds off in the opposite
direction.

left, right, up or down- the text moves across the screen in the indicated direction. After it exits the
screen, it reappears coming in on the opposite edge in a random location.

stationary- the text stays where it is placed.

stationary left- the text is placed to the left of the graphic in slot 1. This is a good way to put a label by a
graphic. If there is no graphic in slot 1, the text will be placed on the very left side of the screen. If the
graphic in slot 1 is wholly or partially off the screen, the text will always be completely on the screen as
close to the left side of the graphic as possible.

stationary right, stationary up or stationary down as for stationary left but on the indicated side.



The Text Out effect determines how the text leaves the screen. The options are:

Zoom- the text decreases in size until it disappears.

Random Blocks- random blocks disappear until all the text is gone. The effect speed determines the size
of the blocks - the faster the speed, the larger the blocks.

Horizontal Contract- the top and bottom lines of the text disappear until they meet in the middle.
Vertical Contract- the left and right sides of the text disappear until they meet in the middle.

Horizontal Scan- the top or bottom of the text disappears, then it erases to the other edge.

Vertical Scan- the left or right of the text disappears, then it erases to the other side.

Instantaneously- the entire text disappears at once.

None- the text is not erased from the screen - a copy of the text is left behind. However, anything moving
over it erases the part it moves over until eventually it is all erased.



The Use Exact Font check box, if checked, ensures that text will look the same on all systems regardless
of the fonts installed on that system. Basically, it turns the text into a BMP and uses it in the final screen
saver.



The Speed bar determines how fast the text moves across or around on your screen. The speed number
is actually how many pixels the text moves every update. Thus, at the default Update Rate of 200ms, 5

updates occur every second. A block of text with a speed of 10 will therefore move 50 pixels every
second.



The Text Starting Values are dimmed and can't be accessed unless Pixel Offset or % Offset is chosen
for the particular axis. Values can run from -9999 to 9999.



The Text Starting Point is broken into X and Y coordinates for maximum flexibility. Usually you will have
both axes set to the same thing, but they can be different. These options are not available when the
Motion is Stationary Left, Right, Up or Down. The options are:

Keep Old- begin at the same location the text ended at in the previous segment. This is needed to
maintain smooth motion of text from segment to segment. If there was no text in the previous segment, a
Random location is used instead.

Preset- uses standard starting locations based on the selected motion of the text. Bounce generates a
Random location that tries to keep the text block on the screen. Stationary is centered on the axis. Lefft,
Right, Up or Down motion puts the starting location just off the edge of the screen. User defined motion
text uses a random starting location.

Random- places the center of the text block somewhere on the screen. Thus, the text can start partially
off the screen.

Left Side or Right Side on X axis, on the Y axis Top or Bottom- puts the text just off the indicated edge
of the screen.

Pixel Offset- starts the center of the text block the specified number of pixels from the center of the
screen.

% Offset- starts the center of the text block the specified percentage of the screen resolution from the
center of the screen.




The text Keep Black Transparent check box here is similar to the graphic Keep Black Transparent box.
You normally want this on unless you want a black box around your text block.



The text Transparent Fade check box here is similar to the Keep Black Transparent box. You normally
want this on unless you want to see a black box around the text until the effect is finished.



The heart of user defined motion is an understanding of the X-Y coordinate system. The center of the
screen is 0,0. X is the horizontal axis; it increases to the right (+) and decreases to the left (-). The Y axis
is the vertical axis; it increases to the top (+) and decreases to the bottom (-). By setting the sliders to the
proper numbers, you can make an object move in any desired direction.

The text X and Y Speed numbers represent how many pixels the text moves every update. Thus, at the
default Update Rate of 200ms, 5 updates occur every second. Text with an X-speed of 10 and a Y speed
of 3 will therefore move 50 pixels to the right and 15 pixels up every second.



Title Bar

The title bar is located along the top of a window. It contains the name of the application and document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button

Minimize button

Name of the application

Name of the document

B FEEEF

Restore button



Toggle Clip Marker (Edit menu)

Use this command to change the status of a clip marker. The easiest way to set a clip is to click on the dot
on the main screen. A black dot marks the beginning (as well as the end) of a clip and a white dot means
the segment is part of a clip. The keyboard command toggles the dot on the left side of the selected
segment.

See also
Shortcuts

Main Window:
Keys: CTRL+M



Undo (Edit menu)

The undo command can undo the last Edit action - Cut, Replace, Insert, Edit, Clear, Delete, Insert New
Segment. After the last action is undone, the command becomes disabled again.

Shortcuts

Tool bar: EI
Keys: CTRL+Z



The Update Rate determines how often Screen Saver Studio Deluxe redraws every object on the screen.
It is measured in milliseconds, so the default of 200ms means that everything is redrawn every
200/1000ths of a second - that is, 1/5 of a second or 0.2 seconds.

Note that this is the optimum case. It is entirely possible to have so many large graphics that they cannot
all be drawn in the allotted time. To preserve the look of the screen saver on all systems - no matter how
slow - Screen Saver Studio Deluxe figures out how many iterations need to be done and then executes
them no matter how long it actually takes.

Thus, under the default update rate, if a segment is supposed to last 3 seconds, 15 iterations will be
done. This could take 3 seconds as planned or it might take 10 seconds if the system is very slow.



Using Help command (Help menu)

Use this command for instructions about using Help.



Ruler command (View menu)

<< Write application-specific help here. >>



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the
selected menu item or depressed tool bar button, and keyboard latch state. A check mark appears next to
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Tool bar command (View menu)

Use this command to display and hide the Tool bar, which includes buttons for some of the most common
commands in Screen Saver Studio Deluxe, such as File Open. A check mark appears next to the menu
item when the Tool bar is displayed.

See Tool bar for help on using the tool bar.



View menu commands

The View menu offers the following commands:

Tool bar
Command bar
Status Bar
Preview
Show_
Background
Element
Resolution

Show Selection

Thumbnail

Shows or hides the tool bar.

Shows or hides the command bar.

Shows or hides the status bar.

Preview the current screen saver document.

Draw the backgrounds behind each segment in the list.

Determines which segment element should be displayed in the list.
View 1, 2, 4, 8, 16, or 32 segments at once.

Turn on or off the thumbnail which appears when trying to select a
graphic.



Viewing a Preview of the Current Screen Saver

To preview the screen saver scripted by your current screen saver document, select Preview in the

View Menu (Alt V+P), click the Preview button in the command bar or click the Preview Icon in the
Tool bar (

Ep?
). Press Alt+F4 or click Close in the title bar's close box to end the Preview and return to your screen
saver document.

Whenever you are previewing or editing a segment, all graphics will appear in the rainbow

palette. See Building New Screen Savers (.SCR files) or Programs (.EXE files) for more information on
palettes.



Viewing the Background of a Segment

From Screen Saver Studio Deluxe's main screen, it is possible to view your segments without a
background. Simply select Show Background in the View Menu to "uncheck" or turn the option off. Select
Show Background again to "check" or turn it back on. Though you may not use this feature very often, it
can reduce the display time for large screen saver documents and it will make a selected segment easier
to spot.



Viewing the Graphics in a Segment
Graphic 1
FAII
(Graphic J
raphic 4
taphic
taphic
taphic |
raphic &
taphic
Graphic: 10
Tout
Alongside of the main window is a row of tabs that say Graphic 1 down to Text. One of these will be active
and appear to be popped out over the others - graphic 1 in the graphic to the right. When you look at all
the segments in the main screen, you are seeing the graphic (or text) in this slot in the segments. If there
is no graphic in the selected slot in a segment, you will see a view of the background - unless View

Background is turned off in which case you see solid black. This is a quick way to find a segment where
something changes.

JERREEES

There are two ways to change the selected slot. The easiest is to just click on the slot you want to view in
the tab. Or you can select Element in the View Menu and then the desired slot.



Viewing the Segments in a Document

When you create a new screen saver document, the main screen enables you to view four segments
per screen. You can change this to 1, 2, 8, 16, or 32 segments. If your screen savers are usually only one
segment, you will be able to see more of it by viewing only one segment. Conversely, you will want to
view more segments to keep scrolling to a minimum if working with large multi-segment screen saver
documents.

In the lower left hand corner of the main screen is a little ruler that not only graphically shows you how
many segments are being displayed, but also lets you click on a vertical line to change the number of
segments you are viewing.



WAV: A sound format which digitizes an actual sound as a long string of numbers. All systems with sound
cards should be able to play WAVSs.



If you have downloaded your copy of Screen Saver Studio Deluxe, you received only the program and the
help file. You can download ANIMCOMP and the add-on packs of graphics, sounds, icons and more free
from



Background: The mat on which all objects are placed. All other objects are above the background.



BMP: A standard Windows graphic format. If your paint program supports it, when you create new
graphics you should save them as RLE encoded since this usually makes your final screen saver smaller.



Bounce: A special object motion where the object bounces off the edge of the screen instead of moving
off of the screen.



Clip: Aclip is a run of segments that plays from the first segment of the clip to the last segment of the clip.
When the last segment is played, a different clip is chosen at random to be played.



Duration: How long the movement portion of a segment lasts. It can be set to last a certain number
of seconds, or by how a certain object moves.



per Segment (Dynamic): A setting designed for slide shows that calculates a palette for every
segment. You should fade each slide to black before going to the next image, or you will get a palette
flash between segments.



EXE: An executable program. Screen Saver Studio Deluxe can build a Presentation EXE, or a self-
installing screen saver EXE.



Global (Static) Palette: A setting that takes all the graphics from the entire screen saver and makes the
single best palette. The results are usually very good. There is never a palette flash between segments,
but it can take a while for the palette calculation during the build.



High Color: Also known as 16-bit or 65 thousand color, this is a video mode that displays 65,536 colors.
(Also used to describe 15 bit color, a mode that displays 32,767 colors.)



JPG: A popular, lossy graphic format. Because of the compression method used, these may not work
properly with transparent black settings. They will become larger when internally stored in screen savers.



Lossy: A compression scheme that sacrifices information for size reduction. Usually used on graphics.
(like JPG and PNG) under the theory that the human eye can't detect the difference between the original
and the compressed graphic. Unfortunately, Screen Saver Studio Deluxe can run into trouble with
transparent black settings when using lossy graphic formats.



MIDI: A music format where instruments and notes are defined as numbers. Much smaller in size than
WAVSs, MIDIs will play on most properly installed sound cards. However, songs may not sound the same

on different systems.



Object: Either a graphic or a block of text. Objects are the "actors" in your screen saver "movie".



Pixel: The basic unit of the screen, each "dot" on the screen is one pixel. A 640x480 screen resolution
means you can see 640 pixels across and 480 pixels up and down.



PNG: A lossy graphic format. Because of the compression method used, these may not work properly
with transparent black settings. They will become larger when internally stored in screen savers.



Presentation EXE: A stand-alone program. It must be run like any other program - it does not run
automatically like a screen saver. It is exited by a key press.



General Rainbow (Static) Palette: A general palette used while building and previewing your screen
savers. It makes a fairly good approximation for most graphics, but is bad for photographs.



SCR: The file extension of screen saver files.



Screen Saver: A special program that is run automatically after a predefined length of time has passed
with no input to your computer. Any key press or mouse movement exits the program. Originally designed
to keep your monitor's screen from getting burned by constantly displaying the same thing for long
periods of time, screen savers have become fanciful, fun, whimsical programs that amuse or break up the
work-day monotony.



Segment: The basic unit of a Screen Saver Studio Deluxe screen saver. Each segment has three parts: A
beginning where objects Fade In, a middle where objects Move, and an end where objects Fade Out.



Graphic Slot: Graphics in a segment are assigned to one of ten slots to keep track of them. The major
function of a slot is determining how objects pass over each other on screen.



Use Exact Font: A text setting that turns the text in a segment into a graphic - ensuring that all users will
see the font and style used no matter what fonts they have of their system.



SSP: Screen Saver Project. The file that tells Screen Saver Studio Deluxe where to find and how to move
all the objects in your screen saver.



Status Bar

caP

The status bar is displayed at the bottom of the Screen Saver Studio Deluxe window. To display or hide
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus. This area similarly shows messages that describe the actions of tool bar buttons as you
depress them, before releasing them. If after viewing the description of the tool bar button command you
wish not to execute the command, then release the mouse button while the pointer is off the tool bar
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Tool bar
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The tool bar is displayed across the top of the application window, below the menu bar. The tool bar
provides quick mouse access to many tools used in Screen Saver Studio Deluxe,

To hide or display the Tool bar, choose Tool bar from the View menu (ALT, V, T).

Click To
Open a new document.

Ep?
Open an existing document. Screen Saver Studio Deluxe displays the Open dialog box, in which
you can locate and open the desired file.

Save the active document or template with its current name. If you have not named the
document, Screen Saver Studio Deluxe displays the Save As dialog box.

Remove selected data from the document and stores it on the clipboard.
Copy the selection to the clipboard.

Places the contents of the clipboard segment over the current segment
Inserts the contents of the clipboard segment before the current segment

Edits the current segment.

Clears the current segment.

Removes the current segment.

Inserts a new segment before the current one

Undoes the last Edit action

Activate the Icon Editor program

F X 5 8 & &

Previews the current screen saver

L

Creates a screen saver file and possibly a program to that will install it for you.

About your version of Screen Saver Studio Deluxe

X =

Point-and-click help



True Color: Also known as 24-bit or 16 million color, this is a video mode that displays 16,777,216 colors.



Slide Show Wizard

The Slide Show Wizard allows you to quickly make a screen saver out of all the valid graphics in a
specified directory. You will therefore want to set up a directory with just the pictures you want before you
run the Slide Show Wizard.

The wizard will actually make an SSP file. As such, if you have an unsaved project in memory, you will be
alerted when you start a wizard. If you want to save the current SSP, say No to exit the wizard, then save
the current file.

Here are the instructions for the 4 pages in the wizard:

Type Page (1 of 4)

Click the radio button to build a Screen Saver or a Presentation.

You MUST enter a Selection name. This is NOT a filename - it's the internal name that shows up in
Windows list of screen savers. You can use 20 characters of any kind in this name.

Description text is optional. It is seen when viewing the settings dialog of a screen saver. (It can't be seen
in a presentation.)

Click on the Next button to move to page 2.

Images Page (2 of 4)

You may change the icon from the default to any icon (.ICO) file on your system by clicking on the browse
button. (The reset button changes it back to the life-saver around the monitor for a screen saver or the
fish and easel icon for a presentation.)

You MUST select a directory containing the graphics you want to use for your slide show. ALL valid
graphics in this directory will be used! If there is a problem opening a graphic, you will be notified and the
graphic will not be used. When the images have been processed, you will be told how many were found.
(If the number is 0, you will have to pick a different directory!)

You may build one of three kinds of slide shows:

1) One at a time, centered. This places each graphic in the center of the screen. If the graphic is too big
for the screen, you will not see the edges. After it is viewed, it will fade to black before the next slide
comes up.

2) One at a time, randomly placed. As above, but each image will be placed somewhere randomly on the
screen. It will be completely on the screen unless it is too big, in which case it will be centered.

3) Montage, randomly placed without fading. This keeps dropping new pictures on top of old ones - they
never go away, they just keep piling up. Each slide will be placed randomly, but it may be partially off the
screen. You will always see at least a quarter of each slide; it can be half-off any screen edge.

All three slide shows reduce high color depths; the Montage slide-show also uses a global palette. If the
colors of the individual slides do not look good enough in a montage, then use either of the others and
they should get a little to significantly better!

Appearance Page (3 of 4)

You may select as many or as few of the fading effects as you like. Hold down the CTRL key while
clicking on the other effects you want. A random effect is chosen for each slide from the list you



highlighted. NOTE! If you chose to make a Montage slide show, you will not be allowed to choose any
fading effects!

The effect speed affects how fast each slide fades in and out. All slides will use the same speed for both
fading-in and fading-out. Move the thumb around or click on the arrows to change the speed. NOTE! If
you chose to make a montage, you cannot change the effect speed!

The duration sets how long each slide will be on the screen after fading-in and before fading-out. You can
set it to be from 0 to 60 seconds.

Sound Page (4 of 4)

If you would like some sound in your screen saver, click on the Select button and browse around your
system to find a WAV or MIDI file. You can click on the Test button to hear it play and the stop button to
end the test. The clear button means no sound will play.

NOTE! The sound you pick will loop constantly throughout your screen saver, so pick a MIDI file that
loops nicely or an unobtrusive WAV file!

Finishing

When you click on the Finish button, the wizard will process all your images. You will then see a standard
Save As dialog. You can name the file whatever valid 8 character name you want, as well as the specify
the directory where the installer will be saved. After the installer is created, you will be asked if you want
to run it to set it up.

You then go back to the main screen -- and all of your slides are in the segments! You can save the SSP if
you'd like, or add or delete some segments, then rebuild it, etc.

NOTE! The wizard makes an installer file using compression that will run on any Windows system 3.1 or
better so it will be in the most usable form. When you are presented with the Save As... dialog, you can
click on Cancel to exit the wizard early to by-pass the actual build and compression to quickly get back to
the main screen - your slides will be the current project. you can then Build a screen saver that works on
Windows 95 or better systems and has a long file name, or that doesn't use compression, etc.



Logo Wizard

The Logo Wizard allows you to quickly make a screen saver out of a single specified graphic -- a
company logo, for instance!

The wizard will actually make an SSP file. As such, if you have an unsaved project in memory, you will be
alerted when you start a wizard. If you want to save the current SSP, say No to exit the wizard, then save
the current file.

Here are the instructions for the 4 pages in the wizard:

Type Page (1 of 4)

Click the radio button to build a Screen Saver or a Presentation.

You MUST enter a Selection name. This is NOT a filename - it's the internal name that shows up in
Windows list of screen savers. You can use 20 characters of any kind in this name.

Description text is optional. It is seen when viewing the settings dialog of a screen saver. (It can't be seen
in a presentation.)

Click on the Next button to move to page 2.

Image Page (2 of 4)

You may change the icon from the default to any icon (.ICO) file on your system by clicking on the browse
button. (The reset button changes it back to the life-saver around the monitor for a screen saver or the
fish and easel icon for a presentation.)

You MUST select a graphic to use.

You may have from 1 to 50 copies of your logo on screen at once! (If you choose an AVI file for your logo,
only 1 copy will be seen regardless of the value of this setting.)

Movement Page (3 of 4)

You may select only one motion direction. All copies of your logo will move in this direction. Bouncing
logos always stay on the screen by bouncing off the edges; all the others move off the screen in the
direction indicated then re-enter on the opposite side. If you choose stationary, one logo will be placed in
the center of the screen and the rest will be placed randomly completely on the screen. NOTE! If you
chose an AVl file for your logo, you will not be allowed to choose any motion!

The speed bar controls how fast the logos move around the screen. This can be set from 1 to 50, which
equals 5 to 250 pixels per second. Move the thumb around or click on the arrows to change the speed. If
you have more than one logo, at least one will move at the defined speed, the rest will move randomly at
this speed or slower. NOTE! If you chose an AVI file for your logo, you cannot change the effect speed!

Sound Page (4 of 4)

If you would like some sound in your screen saver, click on the Select button and browse around your
system to find a WAV or MIDI file. You can click on the Test button to hear it play and the stop button to
end the test. The clear button means no sound will play.



NOTE! The sound you pick will loop constantly throughout your screen saver, so pick a MIDI file that
loops nicely or an unobtrusive WAV file!

Finishing

When you click on the Finish button, the wizard will process your logo. You will then see a standard Save
As dialog. You can name the file whatever valid 8 character name you want, as well as the specify the
directory where the installer will be saved. After the installer is created, you will be asked if you want to
run it to set it. up.

You then go back to the main screen -- and your logo is in the segment! You can save the SSP if you'd
like, or add or delete some segments, etc.

NOTE! The wizard makes an installer file using compression that will run on any Windows system 3.1 or
better so it will be in the most usable form. When you are presented with the Save As... dialog, you can
click on Cancel to exit the wizard early to by-pass the actual build and compression to quickly get back to
the main screen - your logo will be the current project. you can then Build a screen saver that works on
Windows 95 or better systems using a long file name or not using compression, etc.



News and Info

Screen Saver Studio Deluxe 3.0 is the premier product for creating custom screen savers.

If you haven't seen the free extras available for your new software, you absolutely must visit

and click on the Free add-ons button. You'll find sample screen savers with the project files so you can
learn how to make better screen savers! The site also has tips and hints, the latest info, patches and
much more!

Want to sell the screen savers you make or use them to promote a business? Then you'll need our
Screen Saver Studio Professional License version. Go to

and click on the Upgrade Now button and you'll get a discount when you upgrade to a Professional
License version!



The View button allows you to see a sample of what the segment looks like. There will be a little bar that
you can close to exit the view, or you can just press ESC.

NOTE! Sometimes this view will not reflect what you will see in the final screen saver since the starting
positions of graphics, background elements, etc. may be have been set in previous segments.



The Apply button "sets" the changes on all the property sheets since you last clicked Apply.



The Background Clear Button resets the background to Solid Color, black.



The Timing Clear button sets the segment to end after 10 seconds. It does not affect any other settings.



Command Bar command (View menu)

Use this command to display and hide the Command bar, which consists of big buttons for Getting
Started, Slide Show and Logo Wizards, Preview and Build and news and Info. A check mark appears next
to the menu item when the Command bar is displayed.

See Command Bar for help on using the Command bar.



Command Bar
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The command bar is displayed across the top of the application window, below the tool bar. The
command bar provides quick mouse access to many tools used in Screen Saver Studio Deluxe.
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&
Info

To hide or display the Command bar, choose Command bar from the View menu (ALT, V, C)

Click To

[Started= | This plays the interactive help that shows you how to build our sample screen saver. If
the program is missing, it shows you the Quick example section of the help file.

Stide

Show
This calls up the Slide Show Wizard - the easiest way to make a screen saver from the

pictures in a single directory.

a4 This calls up the Logo Wizard, a simple way to make a bouncing logo screen saver.

Em . .
Previews the entire screen saver.

Bl

Builds the screen saver.

5 W)

Info Tries to connect you to the proper page of where you can

read about the latest updates, patches, add-ons and news as well as news about contests, etc.



Tools Menu

The Tools Menu offers the following commands, which provide you assistance with this application:

Icon Editor Opens the Icon editor.
Slide Show Runs the Slide Show Wizard.
Wizard

Logo Wizard Runs the Logo Wizard.



My 1st Screen Saver
Getting Started (Help menu)

This plays the interactive file that shows you how to build a sample screen saver.

Shortcuts

Ep’
Command bar
Keys: ALT V+G



Slide show Wizard

This runs Slide show Wizard - the easier way to turn the graphics in a directory into a screen saver.

Shortcuts

Ep’
Command bar
Keys: ALT T+S



Logo Wizard
The runs the Logo Wizard, the easy way to make a single graphic screen saver.

Shortcuts

Ep’
Command bar
Keys: ALT T+L



News & Info

Goes to www.screensaverstudio.com for the latest breaking developments!

Shortcuts

Mew
&
Command bar Infe

Keys: ALT H+S



Adding Segments



This plays the interactive file that shows you how to build a sample screen saver.

Shortcuts

[,
Command bar
Keys: ALT V+G



Tips and Hints

Tip: If you find that the editor is slow when you have large photos in the graphic slots, you can:

1) Set the View to a slot without graphics in it. You'll be looking at the background of the segments.
2) Reduce the number of segments viewed to 1 or 2.

3) Click on Reduce High-Color Depth. (You can turn it off when you make your final build.)

4) Turn off Use image compression. (You can turn it back on when making the final build.)

Tip: If you want to combine different fonts, color and styles in a single text block, you have to make the
desired layout in a paint program and save it as a graphic.

Tricky Tip: You can create a sense of random sound by associating sound with an invisible, bouncing
graphic or text that is just a single space. For instance, a 1x1 pixel, black graphic with the motion set to
bounce will generate the desired sound when it bounces off an edge of the screen. Since the graphic is
invisible, the sound will have the appearance of being random! If you then duplicate a run of segments
with a duration of 1 second, you change the sound in each one for further randomization.

NOTE! It is entirely possible to set conditions for various text and graphic elements which keep any
segment from ever ending even when it should! Screen Saver Studio Deluxe detects most (if not all) such
conditions and warns you against proceeding.



This check box. determines if your graphics are internally stored as JPGs or BMPs. When this box is not
checked, all of your source graphics are internally stored as BMPs. (Except JPGs and PNGs which are
stored as JPGs.) This can make your screen saver quite huge.

When this box is checked, all graphics are internally stored as JPGs. This usually makes for much smaller
screen savers, but:

1) Graphics may look worse than the originals due to the compression,

2) Transparent black areas may be affected,

3) Working with the editor may become unwieldy on slow systems.



Use Image Compression command (File menu)

Use this command to toggle the internal storage method for graphics in Screen Saver Studio Deluxe.
When on, all graphics will be stored as JPGs. When off, all graphics will be BMPs except JPGs and PNGs
which will be JPGs.

Shortcuts
Keys: ALT F+U






